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Introduzione
Questa guida va utilizzata per la diagnostica e la risoluzione di problemi in

cui si potrebbe incorrere durante l’utilizzo del software QuarkXPress®. Se avete

ancora bisogno di aiuto dopo aver seguito queste istruzioni e aver ricercato

una soluzione al vostro problema nella sezione Quark® tech•notes del sito

Web euro.quark.com, raccogliete le informazioni più rilevanti sul vostro

sistema prima di contattare il supporto tecnico di Quark.

Questa guida presume che abbiate già acquisito familiarità con le funzionalità

di base di QuarkXPress e con la maggior parte delle funzionalità di Mac OS® X 

o di Windows®, particolarmente per quanto riguarda processi di stampa e di

gestione delle font. Ciascuna sezione inizia con informazioni generali sul

tema trattato, seguite da informazioni specifiche per ciascuna piattaforma

(se necessario).

UTILIZZO DI QUESTA GUIDA

La Guida alla diagnostica e risoluzione di problemi consente un accesso rapido
a informazioni di riferimento e offre una panoramica di tecniche di base sulle
procedure di diagnostica e risoluzione problemi.

PRESUPPOSTI
Questa Guida presume che abbiate già acquisito familiarità con il computer e
che siate in grado di:

• Lanciare un’applicazione

• Aprire, salvare e chiudere i file

• Usare menu, finestre di dialogo e palette

• Utilizzare il mouse, i comandi da tastiera e i tasti modificatori

• Stampare documenti

• Gestire le font

• Utilizzare il sistema operativo

Se avete bisogno di aiuto in una o più di queste aree, consultate la 
documentazione inviata in dotazione con il computer o altre risorse disponibili.
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CONVENZIONI TIPOGRAFICHE
Questa guida ha adottato varie convenzioni tipografiche che agevolano il
reperimento rapido delle informazioni necessarie:

STILE GRASSETTO
I nomi dei comandi di menu, finestre di dialogo e altri controlli di QuarkXPress
appaiono in grassetto. Ad esempio: “Scegliete Stampa dal menu Archivio/File.”

RIFERIMENTI E FRECCE
Ogni volta che si fa riferimento a una funzionalità, viene indicato come
accedere a quella funzionalità. Ad esempio: “La finestra di dialogo Utilizzo
(menu Utilità) consente di visualizzare le font e le immagini utilizzate nel
layout.” In alcuni casi, le frecce rappresentano il percorso di menu per accedere
alla funzionalità in questione. Ad esempio: Scegli Utilità > Utilità > Font per
visualizzare le font utilizzate nel layout.”

NOTE
Le note forniscono informazioni utili su determinate funzionalità.

    UTILIZZO DI QUESTA GUIDA
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Capitolo 1: In che cosa consiste
esattamente la diagnostica e
risoluzione di problemi?

La diagnostica e risoluzione problemi è il processo di eliminazione sistematica

di variabili per determinare la causa effettiva di un problema.

PROCEDURA DI DIAGNOSTICA E RISOLUZIONE DI PROBLEMI

Se non avete mai provato a diagnosticare un problema di computer fino ad ora,
non sentitevi intimiditi. Nella nostra vita quotidiana, ci ritroviamo spesso a
svolgere funzioni di diagnostica e molto probabilmente avete assistito più di
una volta a un processo di diagnostica in atto.

Se avete avuto bisogno di riparazioni per la vostra casa o per la vostra macchina,
ad esempio, avete sicuramente partecipato a un processo di diagnostica.
Supponiamo che abbiate un lavandino che perde. L’idraulico vi chiederà innanzi
tutto dove si verifica la perdita (dal rubinetto? dalla manopola?), quindi di
che tipo di perdita si tratta (una goccia o due? un flusso ininterrotto?), quanto
spesso si verifica la perdita (tutti i giorni? soltanto dopo aver innaffiato il
giardino?) e quando avete notato la perdita la prima volta. Una volta risposto
a tutte queste domande, vi potrebbe venire posta una serie di altre domande
in base alle informazioni fornite. Se la perdita d’acqua è iniziata d’improvviso o
se avete recentemente fatto delle modifiche al lavandino o alle tubature. Quindi,
l’idraulico eseguirà una serie di test. Proverà ad esempio ad aprire altri rubinetti,
a stringere o allentare delle viti o a rimuovere il rubinetto. Grazie a tutte queste
domande e ai risultati del test, l’idraulico sarà in grado di formulare una diag-
nosi, come ad esempio delle guarnizioni danneggiate intorno alle filettature del
rubinetto o dei problemi con le tubature. Può darsi che l’idraulico voglia eseguire
o suggerire altri test oppure prescrivere dei rimedi come ad esempio sostituire le
guarnizioni o i connettori delle tubature. La perdita d’acqua potrebbe sparire
per sempre o potrebbe riapparire ancora dopo un po’di tempo.

Quando si conducono delle prove su un computer o su un software, si assume
lo stesso ruolo di una persona incaricata di riparazioni normali, ossia occorre
prima eseguire dei test per determinare il tipo di problema, concentrarsi
sulla probabile causa del problema e trovare quindi una soluzione permanente 
o provvisoria.

                                                     PROCEDURA DI DIAGNOSTICA E RISOLUZIONE DI PROBLEMI
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ESECUZIONE DELLA PROCEDURA DI DIAGNOSTICA E 

RISOLUZIONE DIPROBLEMI

La diagnostica e risoluzione di problemi è un processo estremamente logico che
richiede spesso di porsi e di rispondere a determinate domande. Segue una
panoramica generale sulla procedura di diagnostica e risoluzione di problemi.

Prima di poter determinare la causa di un problema, occorre avere ben chiara la
natura del problema stesso. Se la stampa del vostro layout è di qualità scadente,
che cosa significa esattamente “scadente”? Mancano dei colori o dei colori
non sono i colori corretti? Le font non sono quelle definite? Appaiono delle
righe nere sulla pagina? 

Una volta identificato il problema, potete iniziare a eliminare sistematicamente
le variabili ad esso associate. Se il problema è il colore, avete provato a usare
una stampante diversa? Potete stampare da altre applicazioni? Potete stampare
da altri progetti QuarkXPress? 

Mano a mano che eliminate variabili, inizierete a vedere qualche risultato e a
formarvi quindi un’idea della causa del problema. Continuate a condurre dei
test fino a quando non avete conferma dei vostri sospetti e potete quindi pro-
cedere a determinare il rimedio migliore. Una volta applicato il rimedio, avete in
pratica concluso la procedura di diagnostica e risoluzione di quel particolare
problema. Se la soluzione consiste in un aggiramento del problema o in una
soluzione a breve termine, potreste ritrovarvi a dover diagnosticare e risolvere
ancora il problema.

TRE MODELLI DI DIAGNOSTICA

Se volete diagnosticare e risolvere un problema associato a QuarkXPress, potete
accelerare il processo seguendo il sistema dei tre modelli che suddividele le
prove in tre aree specifiche, ossia — progetto, applicazione e sistema opera-
tivo. Il sistema dei tre modelli di diagnostica è utile soprattutto nel caso di
problemi riproducibili.

Supponiamo che abbiate un problema cronico di arresto anomalo. Iniziate a
condurre delle prove sul progetto, creando un nuovo progetto e ripetendo
l’azione che ha causato il problema. Se il problema non si verifica nel nuovo
progetto, significa che è associato al progetto originale. Dovete quindi condurre
delle altre prove sul progetto originale.

Se il problema si verifica anche nel nuovo progetto, potete procedere a condurre
delle prove sull’applicazione. Il problema si verifica se isolate l’applicazione
QuarkXPress? (Istruzioni per isolare QuarkXPress sono disponibili nella sezione
“Problemi a  livello di applicazione” del Capitolo 2, “Arresti anomali”. In caso
contrario, provate a condurre delle prove sul software XTensions® e su altri file

    ESECUZIONE DELLA PROCEDURA DI DIAGNOSTICA E RISOLUZIONE DIPROBLEMI
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ausiliari contenuti nella cartella di QuarkXPress e nella cartelle delle Preferenze
Quark. Se il problema persiste, occorrerà condurre delle prove sul sistema.

Per poter condurre queste prove, dovrete disattivare le font, le estensioni del
sistema, gli elementi di avvio e qualsiasi altro elemento controllato del sistema,
come ad esempio i driver del video. Collegatevi come utente di default oppure
riavviate il computer in modalità sicura. Il problema si verifica ancora? Se non
si verifica più, significa che una componente a livello di sistema è la causa
probabile del problema. Se si verifica ancora, dovrete provare a condurre delle
prove su QuarkXPress installato in un altro sistema.

IL METODO BINARIO

Se avete contattato il supporto tecnico in passato, potreste aver già usato il
metodo binario, una tattica comunemente adottata per diagnosticare e risolvere
problemi associati a estensioni del sistema, font e software XTensions.

Supponiamo che abbiate determinato che una font danneggiata sia la causa
del problema ma che non sappiate quale sia la font responsabile. Utilizzando
il metodo binario, dovrete disattivare metà delle font e ripetere l’azione che ha
causato il problema. Questo metodo indicherà in quale metà delle font si trova
la font danneggiata. Se il problema si ripete, significa che la font danneggiata
si trova nel gruppo di font non eliminate. Se non si verifica più, significa che la
font danneggiata si trova nel gruppo di font eliminate. Una volta identificato il
gruppo di font che contiene la font danneggiata, potete continuare a disattivare
metà delle font rimanenti fino a quando non identificate la causa del problema.

PROBLEMI CASUALI DI DIAGNOSTICA E RISOLUZIONE DI PROBLEMI

Possiamo definire problemi casuali i problemi che non sono riconducibili a
una costante. Poiché non è semplice determinarne la causa, potrebbe essere
difficoltoso condurre delle prove.

Sebbene i tre modelli di diagnostica e il metodo binario siano applicabili a
problemi riproducibili (ossia a problemi che possono venire ricreati seguendo
determinati passi sequenziali), i problemi casuali sono molto più difficoltosi
da diagnosticare. Poiché diverse azioni possono portare allo stesso risultato,
isolare la causa potrebbe richiedere più tempo. Ad esempio, se il computer
subisce spesso un arresto anomalo mentre sono aperti diversi documenti e
si stanno utilizzando varie applicazioni, sarà difficile determinare da dove
cominciare. In questo caso, iniziate cercando di determinare se il problema
è riproducibile. Se non è riproducibile, provate ad annotare tutte le volte si
verifica, il progetto aperto in quel momento, le azioni compiute e quali altre
applicazioni sono aperte. È possibile che possiate identificare una costante.
Potreste scoprire che il computer subisce un arresto anomalo quando una
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determinata applicazione è aperta nel background oppure dopo un determinato
periodo di tempo. Potreste anche scoprire che tutti gli arresti anomali sono in
qualche modo associati a immagini grafiche o a font.

Prendete delle note tutte le volte che iniziate a condurre prove. Queste possono
essere estremamente utili quando apportate delle variazioni alle prove che
conducete e, se decidete di contattare il supporto tecnico di Quark, queste
informazioni possono aiutarvi a risolvere il problema più rapidamente
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Capitolo 2: Arresti anomali
La diagnostica e risoluzione di problemi associati ad arresti anomali richiede

una procedura logica e sistematica. Prima di tutto, cercate di determinare se il

problema può essere riprodotto e annotate le azioni necessarie a riprodurre il

problema. Diagnosticate quindi l’origine del problema, eliminando sistematica-

mente tutte le variabili possibili e ripetete le azioni che portano alla riproduzione

del problema, fino a quando non ne identificate la causa.

Arresti anomali possono venire classificati spesso come problemi a livello di

progetto, a livello di applicazione o a livello di sistema. A volte, una correzione

apportata al progetto risolve il problema. A livello di applicazione, il problema

potrebbe essere causato da file associati, come ad esempio software XTensions, 

il file “XPress Preferences” o altri file supplementari. I problemi a livello di

sistema possono essere causati da una risorsa a livello di sistema come ad

esempio il pannello di controllo o una determinata font.

SEGNALAZIONE DI PROBLEMI DI INTERRUZIONE ANOMALE IN MAC OS

Mac OS X include l’utilità Console che crea automaticamente un report del-
l’arresto anomalo quando un’applicazione viene inaspettatamente interrotta.
Se state utilizzando la versione Ma OS 10.4 o versione successiva, la funzione
di generazione di una segnalazione di arresti anomali è attiva per default.

Se QuarkXPress si chiude inaspettatamente, un file di registro degli arresti
anomali viene aggiornato e diviene disponibile per la visualizzazione nell’utilità
Console, nel percorso “/Applications/Utilities.” Nell’elenco Logs cercate i report
per l’utente sugli arresti anomali dell’applicazione nel percorso seguente:
“~/Library/Logs/CrashReporter/QuarkXPress.crash.log.” Le interruzioni anomale
a livello di applicazione sono accessibili in “/Library/Logs/CrashReporter.”
Tenete il report a portata di mano quando chiamate il supporto tecnico di
Quark oppure potete anche inviare il file *.log con un messaggio e-mail.
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SEGNALAZIONE DI ARRESTI ANOMALI IN WINDOWS

Il file di registro sugli arresti anomali viene aggiornato ogni volta che
QuarkXPress subisce una chiusura inaspettata. Potete visualizzare il registro
degli arresti anomali di QuarkXPress —, chiamato “Error.log”—, nella cartella
dell’applicazione di QuarkXPress. Potete fare riferimento a tali registrazioni
quando chiamate il supporto tecnico di Quark oppure potete anche inviare il
file di registro (o il testo del file di registro) in un messaggio e-mail.

Quando un’applicazione subisce un arresto anomalo in Windows, viene
visualizzata una finestra di dialogo che vi dà la possibilità di inviare infor-
mazioni a Microsoft®. Quark è in costante contatto con Microsoft per valutare
tali problemi e le vostre informazioni verranno utilizzate nello sviluppo di
versioni future.

PROBLEMI A LIVELLO DI PROGETTO

I problemi di arresti anomali a livello di progetto sono problemi associati a
un progetto o a un gruppo di progetti specifici. I problemi a livello di progetto
possono essere causati da un elemento insito nel progetto stesso, come ad
 esempio un’immagine grafica, una font o un oggetto di QuarkXPress. Il primo
passo verso una soluzione di questo tipo di problema è determinare la sua
categoria. Prima di tutto, riportate il computer al suo stato originale prima
dell’interruzione anomala. Ripetete quindi le azioni eseguite prima che si
verificasse l’arresto anomalo. Se il problema è riproducibile, potrete osservare
una costante e determinare se l’arresto anomalo avviene ad esempio quando
si apre o mentre si sta lavorando o stampando un progetto.

Anche se risolvete il problema, potrebbe essere utile inviare il progetto origi-
nale al supporto tecnico di Quark in modo che Quark possa raccogliere le
informazioni necessarie ed utilizzarle in fase di sviluppo delle future versioni
di QuarkXPress. Il contenuto del progetto verrà mantenuto strettamente con-
fidenziale. Vedere la sezione “Come contattare il supporto tecnico di Quark”
per informazioni sull’invio di questi file a Quark.

AGGIUNTA DI LAYOUT A UN ALTRO PROGETTO 
Prima di eseguire delle prove su immagini, font, elementi della pagina di
QuarkXPress e PPD per determinare l’origine del problema emerso, potrebbe
essere utile provare ad aggiungere il layout problematico a un altro progetto.
Procedete come segue:

1  Chiudete il progetto che contiene il layout problematico.

2  Create un nuovo progetto.
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3  Scegliete File/Archivio > Aggiungi, selezionate il progetto contenente il
layout problematico e fate quindi clic su Apri. Viene visualizzata la finestra di
dialogo Aggiungi.

4  Fate clic su Layout nell’elenco a sinistra, selezionate il layout problematico
dall’elenco Disponibile e fate quindi clic sul pulsante con la freccia rivolta
verso destra per spostare il layout nell’elenco di destra.

5  Fate clic su OK. Il layout problematico viene aggiunto al nuovo progetto.

TRASCINAMENTO DI PAGINE TRA VARIPROGETTI IN 
MODALITÀ MINIATURE
Se il problema persiste dopo aver aggiunto un layout, potete provare a
trascinare le pagine tra vari progetti in modalità Miniatura (chiamata anche
“trascinamento miniature”).

Il trascinamento di miniature è utile per il recupero di pagine di progetti
danneggiati nonché per copiare le pagine master in un nuovo progetto. Il
trascinamento di miniature copia elementi e pagine esistenti in una nuova
struttura di progetto. Ci si riferisce al progetto da cui state trascinando le pagine
come “progetto d’origine”. Ci si riferisce al progetto su cui state trascinando
le pagine come “progetto di destinazione”.

***       Potete utilizzare diverse visualizzazioni di layout per trascinare delle pagine
da un layout a un altro di un progetto (Finestra > Nuova finestra).

TRASCINAMENTO DELLE MINIATURE
Per trascinare le miniature, procedete come segue:

1  Aprite il progetto d’origine e annotate le impostazioni applicate al layout
(Layout > Proprietà del layout).

2  Create un progetto di destinazione che abbia le stesse dimensioni (o delle
dimensioni più grandi) e le stesse impostazioni (pagine affiancate o non 
affiancate) del progetto d’origine.

***       Viene visualizzata un’avvertenza se tentate di trascinare le pagine in un layout
con dimensioni di pagina inferiori o se cercate di trascinare pagine affiancate
in un layout a pagine singole.

3  In entrambi i layout, scegliete Visualizza > Miniatura.

4  Scegliete Finestra > Affianca (orizzontalmente o verticalmente).
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5  Selezionate la pagina (o le pagine) che volete portare nel layout d’origine:

• Per selezionare una pagina, fate clic su quella pagina.

• Per selezionare un gruppo di pagine, fate clic sulla prima pagina, premete
Maiusc. e fate clic sull’ultima pagina del gruppo.

• In Mac OS X, selezionate delle pagine non sequenziali premendo il tasto
Mela e facendo quindi clic su ciascuna pagina.

• In Windows, selezionate delle pagine non sequenziali premendo il tasto Ctrl e
facendo quindi clic su ciascuna pagina.

6  Trascinate le pagine nella posizione desiderata del layout di destinazione.

***       Quando trascinate delle miniature dal layout di origine al layout di destinazione,
il puntatore a freccia cambierà quando si trova in un punto in cui è possibile
posizionare le pagine. Se il posizionamento delle nuove pagine non forza le
pagine esistenti a spostarsi, verrà visualizzato uno dei tre puntatori con l’icona
di pagina (pagina a una facciata, pagina affiancata sinistra o pagina affiancata
destra). Se il posizionamento delle nuove pagine forza le pagine a spostarsi,
verrà visualizzato uno dei tre puntatori a freccia (forzatura verso sinistra, verso
destra o verso il basso). Non potrete trascinare le pagine a meno che non venga
visualizzata una di queste icone.

7  Se state trascinando delle miniature per recuperare delle pagine da un layout
danneggiato, eliminate la pagina vuota ossia la prima pagina d’origine del
layout di destinazione (Pagina > Elimina), in quanto questa pagina non è
più necessaria.

8  Salvate il nuovo layout e provate a stamparlo, a farlo scorrere o provate ad
eseguire alcune operazioni su di esso. Se il layout non subisce più arresti anomali,
significa che il problema risiedeva nella struttura del layout originale. La struttura
della pagina rimane tuttavia la stessa, per cui se il vostro layout contiene delle
pagine danneggiate, potrebbe continuare a subire arresti anomali.

***       Qualsiasi specifica di fogli stile, colore, tratteggi e strisce o sillabazione e
giustificazione applicata agli oggetti del progetto d’origine, verrà aggiunta al
progetto di destinazione. (Le specifiche non utilizzate non verranno incluse.)
Tuttavia, elenchi, link ipertestuali, famiglie di font, menu, meta tag e menu
sovrapposti non vengono copiati dal progetto d’origine al progetto di desti-
nazione. Per copiare queste specifiche dal progetto d’origine al progetto di
destinazione, scegliete File/Archivio > Aggiungi nel progetto di destinazione.
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***      Se una delle specifiche del progetto d’origine ha lo stesso nome di una specifica
del progetto di destinazione, vengono utilizzate le specifiche del progetto di
destinazione. (Ad esempio, se un colore ha lo stesso nome ma una definizione
diversa, l’oggetto sarà il colore specificato nel progetto di destinazione.) 

Se viene visualizzato il messaggio di Preferenze non corrispondenti quando
aprite il progetto d’origine e fate clic su Mantieni le impostazioni del progetto,
le impostazioni delle preferenze potrebbero risultare diverse nel progetto d’o-
rigine e nel progetto di destinazione, il che potrebbe causare un riscorrimento
del testo nel progetto di destinazione.

Le pagine master non possono venire visualizzate nella schermata delle
Miniature. Se tuttavia trascinate le pagine del progetto, le pagine master
applicate alle pagine del progetto vengono copiate nel progetto di destinazione.
(Le pagine master non utilizzate non vengono copiate.) Se una pagina master
del progetto d’origine ha lo stesso nome della pagina master del progetto di
destinazione, la pagina master assumerà un nuovo nome quando viene copiata.
Per assegnare un nuovo nome o per eliminare una pagina master, visualizzate 
la palette Layout della pagina se questa non è ancora visibile (Finestra >
Layout della pagina). Per assegnare un nuovo nome alla pagina master, fate
clic sul nome della pagina master e immettete il nuovo nome. Per eliminare
una pagina master, fate clic sulla pagina master per selezionarla e fate quindi
clic sull’icona di eliminazione.

ARRESTO ANOMALO DURANTE L’APERTURA DEI PROGETTI
Se QuarkXPress subisce un arresto anomalo all’apertura di un particolare 
progetto, potete avviare un processo di convalida del progetto che consente 
a QuarkXPress di correggere eventuali discordanze presenti nel file.

1  Scegliete File/Archivio > Apri.

2  Selezionate il progetto problematico e premete Control+Maiusc+Option+Tasto
Mela (Mac OS) oppure Ctrl+Alt+Maiusc (Windows) prima di selezionare Apri
nella finestra di dialogo Apri. (Tenete presente che questo potrebbe causare
un riscorrimento.)

3  Se il progetto si apre senza difficoltà, utilizzate la procedura di trascinamento
della miniatura per creare un nuovo progetto.

ARRESTO ANOMALO DURANTE L’IMPORTAZIONE DI IMMAGINI
GRAFICHE (MAC OS)
Se QuarkXPress si interrompe inaspettatamente durante l’importazione di
un’immagine grafica, verificate l’estensione del file per accertare che sia un
tipo di file supportato. Se un file ha un’ estensione non supportata, potrebbe
causare un’interruzione anomala di QuarkXPress.
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ARRESTO ANOMALO DURANTE LA STAMPA DI IMMAGINI GRAFICHE
Alcune immagini grafiche potrebbero causare arresti anomali. Se il problema si
verifica durante la stampa, provate a stampare il progetto senza le immagini.
Procedete come segue:

1  Scegliete Archivio/File > Stampa. Fate clic sul riquadro Immagini. 

2  Nell’area Opzioni immagine, scegliete Solo testo dal menu a discesa Output.
Se il progetto viene stampato, un’immagine danneggiata potrebbe essere la
causa dell’arresto anomalo.

In questo caso, continuate con le operazioni descritte di seguito per identificare
l’immagine grafica che causa il problema.

3  Scegliete ancora Archivio/File > Stampa. Fate clic sul riquadro Immagini,
selezionate il menu a discesa Output e quindi Normale.

4  Fate clic su Conserva le impostazioni.

5  Scegliete Utilità > Utilizzo e fate clic sul riquadro Immagini.

6  Premete Maiusc. e selezionate tutti i nomi di immagini incluse nella colonna
Nome. Fate clic sul menu Stampa e selezionate No per rimuovere tutte i segni
di selezione; questa azione sopprime la stampa di tutte le immagini.

Potete quindi selezionare un’immagine per volta e provare a stamparla oppure
potete utilizzare il metodo binario per eseguire delle prove sulle immagini. Se il
lavoro di stampa si interrompe inaspettatamente, potete individuare la causa
imputabile probabilmente all’ultima immagine o al gruppo di immagini non
ancora soppresse. Una volta accertato che il problema risiede in un’immagine,
importatela in un nuovo progetto e provate a ristamparla. Se il problema si
ripete, provate ad aprire l’immagine nell’applicazione d’origine e salvatela con
un nuovo nome e con un nuovo formato di file. Importate la nuova immagine 
e cercate di stampare ancora il progetto. Se questo non risolve il problema,
l’immagine potrebbe essere danneggiata e potrebbe essere necessario ricrearla 
e reimportarla. 

***       Prima di ricreare l’immagine, potrebbe essere utile aprirla in un’applicazione di
correzione delle immagini, copiare tutto il suo contenuto, incollarlo in un nuovo
file, salvare il file e quindi reimportare il nuovo file nel progetto QuarkXPress.

    PROBLEMI A LIVELLO DI PROGETTO

 10   |   CAPITOLO 2: ARRESTI ANOMALI



***       La funzionalità Anteprima a piena risoluzione può a volte correggere problemi
di anteprime danneggiate. Nella finestra di dialogo Preferenze applicazione
(QuarkXPress/Modifica fate clic su Anteprima a piena risoluzione e specifi-
cate un percorso nella cache dell’anteprima per archiviare i file di anteprima.
Se avete selezionato Tutte le anteprime a piena risoluzione nella finestra di
dialogo Preferenze applicazione (l’impostazione di default), tutte le immagini
del progetto che sono state definite per una visualizzazione a piena risoluzione,
verranno visualizzate a piena risoluzione. Deselezionate Disattiva le anteprima 
a piena risoluzione all’Apertura per accertare che le immagini per le quali
Visualizza > Anteprime a piena risoluzione è stato selezionato, utilizzino i
file cache di anteprima all’apertira del vostro progetto.

ARRESTO ANOMALO DURANTE LO SCORRIMENTO
Se si verifica un arresto anomalo quando scorrete a una determinata area del
progetto, questo potrebbe essere sintomatico di un’immagine danneggiata.
Questo problema potrebbe anche essere causato dall’anteprima danneggiata di
un’immagine. Se sospettate che più di un’anteprima sia danneggiata, scegliete
Archivio/File > Apri e navigate al progetto. Mentre fate clic su Apri, premete
Tasto Mela/Ctrl. Questo creerà nuove anteprime per le immagini TIFF e JPEG e
reimporterà le anteprime dei file EPS.

Se la reimportazione di anteprime non funziona, eseguite delle prove per
identificare le immagini danneggiate. Per identificare le immagini danneggiate
all’interno di un progetto, iniziate simulando le immagini del progetto.
Procedete come segue:

1  Scegliete QuarkXPress/Modifica > Preferenze. In Layout di stampa, Generale,
selezionate Simula immagini. Questa selezione impedirà che le immagini
del vostro progetto vengano visualizzate fino a quando non le selezionate.
L’anteprima dell’immagine verrà sostituita da un riquadro grigio.

2  Una volta simulate le immagini, continuate a scorrere o a lavorare sul progetto,
ripetendo le azioni che avevano preceduto l’arresto anomalo. Se si verifica
ancora l’arresto anomalo malgrado la simulazione delle immagini, potrebbe
essere necessario eseguire delle prove sulle font o su altri  elementi della
pagina di QuarkXPress (vedere le sezioni “Font” e “Oggetti di QuarkXPress”
più avanti in questo capitolo).

Se non riuscite a scorrere o a lavorare sul progetto malgrado le immagini siano
state simulate, la causa del problema potrebbe essere un’anteprima dell’immag-
ine o l’immagine stessa danneggiata. Potrebbe anche trattarsi di una finestra
immagine danneggiata. Scorrete lungo il progetto, facendo clic su ciascuna
immagine per visualizzarla. Se si verifica un arresto anomalo subito dopo aver
visualizzato una determinata immagine, quell’immagine è probabilmente la
 causa del problema. Potrebbe essere necessario eliminare la finestra immagine 
e quindi reimportare l’immagine.
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GESTIONE DI OGGETTI “NON ELIMINABILI”
Se non potete eliminare un’immagine o una finestra immagine prima che 
si verifichi l’arresto anomalo, potete provare a usare il “trucco della palette”.
Sebbene questa procedura sia applicabile a qualsiasi palette di default di
QuarkXPress, le palette utilizzate più di frequente a questo scopo sono la
palette Colori e la palette Pagina del layout. L’idea è di “nascondere” la pagina
dietro la palette. Se un’immagine o un’anteprima di immagine danneggiata
sono la causa dell’arresto anomalo, non verranno generate sullo schermo e
dovrebbe quindi essere possibile eliminarle.

1  Fate una copia del progetto su cui volete eseguire delle prove. (Ciò vi consente
di ritornare al progetto originale, se necessario.)

2  Lanciate QuarkXPress senza aprire alcun progetto. 

3  Scegliete Finestra > Colori.

4  Spostate e ridimensionate la palette Colori in modo che copra l’intero
schermo.

5  Aprite la copia del progetto problematico. Il progetto e le sue immagini verranno
visualizzati dietro la palette Colori. Se il progetto continua a subire arresti anom-
ali, è improbabile che il problema risieda nella sua visualizzazione. Se l’arresto
anomalo non si verifica, procedete al punto 6.

6  Scegliete Utilità > Utilizzo > Immagini per selezionare l’immagine che
ritenete sia la causa del problema.

7  Fate clic su Mostra. Ciò seleziona l’immagine senza visualizzarla sullo schermo.

8  Chiudete la finestra Utilizzo. Selezionate lo strumento Oggetti e scegliete
Oggetti > Elimina per eliminare l’immagine e la sua finestra. Se volete elim-
inare l’immagine ma volete conservare la finestra, selezionate lo strumento
Contenuto e scegliete Comp./Modifica > Cancella/Elimina:

9  Ridimensionate lentamente la palette, poco per volta; se avete selezionate
l’oggetto giusto, il progetto non si interrompe. In caso contrario, avrete un’idea
su quale immagine dovete concentrare la vostra attenzione quando ripetete
la procedura descritta.

FONT
Se le immagini non sono la causa del problema, potete iniziare ad eseguire
prove sulle font. Potete eseguire prove sulle font associate ad un particolare
progetto o su tutte le font del sistema.

Per eseguire delle prove sulle font di un progetto specifico, potete disattivare
le font prima di lanciare QuarkXPress o potete sostituire le font del progetto.
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Per sostituire le font di un progetto QuarkXPress, procedete come segue:

1  Fate una copia del progetto su cui volete eseguire delle prove. (Ciò vi consente
di ritornare al progetto originale, se necessario.)

2  Se possibile, aprite la copia del progetto e scegliete Utilità > Utilizzo > Font.
Utilizzo > Font. Selezionate tutte le font dell’elenco e fate clic su Sostituisci.
Sostituite le font con una font “standard”, come ad esempio Times, Helvetica
o Arial, oppure con una font che sapete funziona correttamente.

***       Se sostituite tutte le font di un progetto con la font selezionata per le prove,
lefont utilizzate nelle immagini Encapsulated PostScript (EPS) importate non
verranno alterate.

3  Chiudete la finestra di dialogo Utilizzo. Riprovate a scorrere o a stampare il
progetto. Se l’arrestoanomalo non si verifica, significa che esiste una font
danneggiata nel progetto. Se il progetto presenta ancora lo stesso problema,
ritornate alla sezione precedente di questo capitolo, riguardante le immagini,
oppure alla sezione successiva relativa agli oggetti di QuarkXPress.

Utilizzate il metodo binario per identificare la font danneggiata. Eseguite una
copia del progetto originale o ritornate alla copia precedente. Sostituite metà
delle font con le font utilizzate originariamente e lasciate l’altra metà nella
font di prova. Provate quindi a stampare o a scorrere ancora lungo il progetto.
Se il problema si verifica ancora, significa che la font danneggiata si trova nel
gruppo di font non sostituite. Se il problema non si verifica, significa che il
problema risiede nelle font sostituite con la font di prova. Continuare a sostituire
le font, metà per volta, fino a quando non individuate la font danneggiata.

Una volta individuata la font danneggiata, rimuovetela dal sistema e 
reinstallatela dal disco o dal CD-ROM originale.

***       Selezionate Altre informaz. dalla finestra di dialogo Utilizzo per individuare 
il file della font, la sua versione e il nome PostScript e TrueType. Quando
molteplici utenti condividono un sistema, un progetto QuarkXPress potrebbe
contenere molteplici versioni di una font, particolarmente in Mac OS. Più
informaz. vi può aiutare a identificare la font  corretta.

UTILIZZO DELL’UTILITÀ DI GESTIONE DELLEFONT
Gli strumenti di gestione delle font per Mac OS e Windows possono aiutarvi a
ripulire le cache delle font e attivare o disattivare famiglie di font parziali. Diversi
produttori di font forniscono utilità di gestione delle font per entrambe le
piattaforme. Per ulteriori informazioni, vedere il capitolo 4, “Font”.
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OGGETTI DI QUARKXPRESS
Se avete difficoltà a stampare o a lavorare in un progetto QuarkXPress e avete
determinato che le immagini e le font non rappresentano un problema, la causa
potrebbe risiedere in un oggetto contenuto nel progetto.

Gli oggetti di QuarkXPress includono finestre di testo, percorsi di testo, finestre
immagini, finestre Bézier, linee, cornici, fogli stile, specifiche di sillabazione e
giustificazione, tabelle e pagine.

Per eseguire delle prove sugli oggetti di QuarkXPress, fate una copia del progetto.
Lavorando su questa copia, procedete a eliminare sistematicamente oggetti o
pagine dal progetto fino a quando il problema non si verifica più. Il metodo
binario può essere utile a identificare l’oggetto che causa il problema.

PPD
Se un progetto continua a subire arresti anomali quando stampate e avete già
eliminato immagini, font e oggetti QuarkXPress provate a cambiare il PPD
(PostScript® Printer Description) utilizzato dal progetto. Il PPD comunica le
funzionalità della stampante al driver della stampante. Ad esempio, il PPD
può informare il driver sulle funzionalità di colore e formato tabloid disponibili
nella stampante. Quando il progetto viene inviato alla stampante, il driver
della stampante utilizzerà questa informazione per agevolare l’output del
progetto. Se il PPD è danneggiato, potrebbe causare un arresto anomalo
durante la stampa.

Per sostituire il PPD utilizzato da un progetto, procedete come segue:

1  Scegliete Archivio/File > Utilizzo e fate clic sul riquadro Immagini.

2  Selezionate il menu a discesa PPD e cambiate l’impostazione del PPD in
Generico bianco e nero, Generico colori o Generico fotounità a scopo di
prova. Se il progetto viene stampato con il nuovo PPD, significa che il prob-
lema risiedeva nel PPD originale. Potete reinstallarlo o ottenere una versione
aggiornata dal costruttore della stampante.

***       I PPD vengono creati dai costruttori delle stampanti e vengono solitamente
forniti insieme alle stampanti PostScript. Per ulteriori informazioni, contattate
il costruttore della stampante.
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PROBLEMI A LIVELLO DI APPLICAZIONE

Se avete determinato che l’arresto anomalo è a livello di progetto, potete
iniziare a condurre delle prove sull’applicazione di QuarkXPress. Solitamente,
se si verifica un arresto anomalo quando lanciate QuarkXPress e non quando
aprite un progetto specifico, significa che il problema è associato in qualche
modo all’applicazione. Questi tipi di arresti anomali potrebbero essere causati da
un oggetto presente nella cartella QuarkXPress, nella cartelle delle preferenze,
nella cartella dei dati dell’applicazione o in un file a livello di sistema.

ISOLAMENTO DI QUARKXPRESS
Se avete difficoltà a lanciare l’applicazione QuarkXPress, è possibile che un file
ausiliario sia la causa del problema. I file ausiliari possono includere (tra gli
altri) software QuarkXTensions® o software XTensions sviluppate da terzi, il file
“XPress Dictionary” o il file “XPress Preferences”. Dovete isolare QuarkXPress
dai file ausiliari.

PER “NASCONDERE” I SOFTWARE XTENSIONS DI QUARKXPRESS:
1  Navigate alla cartella “XTension” nella vostra cartella del programma

QuarkXPress. Il percorso di default “Disco fisso\Applicazioni\QuarkXPress”
(Mac OS) e “C:\Programmi\Quark\QuarkXPress” (Windows).

2  Inserite “z” prima di “XTensions” nel nome della cartella. Disattivate 
quindi tutti i software XTensions attivi ma conservando i moduli software
XTensions disattivati in precedenza nella cartella “XTensions Disabled” 
(XTension disattivate).

***       Se QuarkXPress non viene lanciato, potrebbe essere necessario eseguire il
 programma di installazione “For System” e reinstallare i file di sistema di 
cui QuarkXPress ha bisogno.

Se sospettate che un componente necessario sia la causa del problema
insorto, non rimuovetelo della cartella ma piuttosto reinstallatelo dal
CD-ROM di QuarkXPress.

PREFERENZE 
QuarkXPress mantiene una serie di file contenenti impostazioni di default del
programma per i fogli stile, colori, specifiche di sillabazione e giustificazione,
eccezioni di sillabazione, tratteggi e strisce, stili di stampa e altre impostazioni.
Le Preferenze possono essere archiviate in una serie di percorsi e QuarkXPress
cerca in vari percorsi seguendo un ordine predefinito per trovare i file durante il
lancio. Se QuarkXPress trova i file delle preferenze da una versione precedente
del software all’interno della cartella QuarkXPress, il software convertirà
queste specifiche in un formato QuarkXPress 7. Se QuarkXPress non trova i
file delle preferenze nella cartella dell’applicazione, creerà dei file nel profilo
dell’utente (~/Library/Preferences/Quark in Mac OS oppure Document and
Settings/user/Application Data/Quark in Windows).
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Questo set di preferenze generate tuttavia useranno impostazioni di default, .per
cui qualsiasi impostazione personalizzata andrà perduta e dovrete ridefinirle.
Una voltaripristinate le preferenze, è consigliabile eseguire una copia dei file
delle preferenze per un eventuale uso futuro. Per eseguire una copia di backup,
copiate semplicemente i file in un volume o in un’unità disco qualsiasi, possi-
bilmente non lo stesso volume dove si trova l’applicazione QuarkXPress. Potete
anche annotare le specifiche, come vostro riferimento personale, in caso abbiate
bisogno di specificarle ancora.

PER “NASCONDERE” LE PREFERENZE QUARKXPRESS:
Se avere già una cartella “Preferences” nella cartella dell’applicazione
QuarkXPress, assegnate alla cartella “Preferences” un nuovo nome. Create quindi
una nuova cartella dal nome “Preferences”. Se non avete una cartella dal nome
“Preferences”, create semplicemente una nuova cartella dal nome “Preferences”
all’interno della cartella dell’applicazione QuarkXPress. QuarkXPress cercherà
per prima cosa qui quando lanciate il software e verranno quindi generati i
nuovi file. Se questo non è il problema, potete semplicemente eliminare la
nuova cartella e assegnare ancora il nome “Preferences” alla vecchia cartella.

PROVE SUI FILE A LIVELLO DI SISTEMA

Se isolando QuarkXPress non si risolve il problema degli arresti anomali,
potete iniziare a eseguire delle prove sui file associati al sistema. Prima di
eseguire le prove, riportate l’applicazione QuarkXPress alle sue impostazioni
originali e accertatevi che i file ausiliari siano nella posizione corretta.

FONT
Se una font è danneggiata o costruita incorrettamente, potrebbe causare un
arresto anomalo al lancio di QuarkXPress. Per eseguire delle prove su font
danneggiate, disattivate le font tramite il sistema o qualsiasi utilità font che
state utilizzando.

Per disattivare le font tramite il sistema, procedete come segue:

1  Navigate alla cartella “Fonts”:

• Mac OS: (Utenti > Librerie > Fonts) oppure la cartelle “Library” (Library >
Fonts). Soltanto gli amministratori possono apportare modifiche alla
cartella “Library”.

• Windows: Scegliete Start > Impostazioni > Pannello di controllo > Font).

2  Create una nuova cartella nel desktop e trascinate approssimativamente metà
dei file delle font in questa nuova cartella.

3  Rilanciate QuarkXPress.

4  Continuate fino a quando non avete identificato la font problematica.
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PPD
Se le prove sulle font non rivelano l’origine del problema, potete anche eseguire
delle prove sul PPD (PostScript File Descriptions). Quando lanciate QuarkXPress,
questo carica automaticamente i PPD. Se un PPD è danneggiato o entra in
conflitto con QuarkXPress, può causare un arresto anomalo.

Per eseguire delle prove sui PPD, procedete come segue:

1  Aprite la cartella “Printer Descriptions”

• Mac OS: (Utenti > Libreria > Centri stampa > PPDs) oppure la cartelle
“Library” (Libreria > Stampanti > PPDs). Soltanto gli amministratori possono
apportare modifiche alla cartella “Library”.

• Windows: (C:\WINDOWS\system32\spool\drivers\w32x86\).

2  Portate circa la metà degli elementi nella cartella “Printer Descriptions” sul
desktop. Se potete lanciare QuarkXPress, significa che uno dei file PPD è la
causa del problema. Potete utilizzare il metodo binario per identificare il
problema nei PPD.

***       I PPD vengono creati dai costruttori delle stampanti e vengono solitamente
forniti insieme alle stampanti PostScript. Per ulteriori informazioni, contattate
il costruttore della stampante.

PROBLEMI A LIVELLO DI SISTEMA

Se le prove condotte sul progetto e la procedura di isolamento di QuarkXPress
descritta prima, non risolvono il problema, è probabile che la causa risieda
nel sistema.

Per verificare se il problema è a livello di sistema, provare ad eseguire le stesse
prove su un altro sistema, preferibilmente identico. Un metodo efficace è di
collegarsi a Mac OS X come un utente diverso oppure riavviare il computer
da una sistema alternativo in Windows. La connessione al sistema come un
utente diverso in Mac OS X invoca diversi file di sistema consentendovi di
confermare se il problema risiede nei file del sistema assegnati a un utente
specifico o se il problema coinvolge l’intero sistema. In Windows, un sistema
alternativo contiene generalmente soltanto i minimi file necessari per l’ese-
cuzione del sistema operativo e ha il vantaggio di essere “pulito”, ossia non
contiene file danneggiati o in conflitto.
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COLLEGAMENTO COME UN UTENTE DIVERSO IN MAC OS X
1  Se non disponete di un collegamento come un utente diverso, scegliete

Menu Apple > Preferenze di sistema > Account per creare un nuovo utente
(Per ulteriori informazioni sulla creazione di nuovi utenti, consultate la 
documentazione di Mac OS X.)

2  Scegliete menu Apple > Log Out.

3  Collegatevi come un altro utente e ripetete la prova. Se il problema persiste,
significa che è associato a un file a livello di sistema. Se il problema non si
ripresenta, è probabilmente associato a un file specifico di un utente; adottate 
il metodo binario per selezionare i file in Utente > cartella Libreria

    PROBLEMI A LIVELLO DI SISTEMA
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Capitolo 3: Stampa
Se ottenete un output inaspettato durante la stampa, o se viene visualizzato un

messaggio d’errore (ma non si verifica un arresto anomalo), le informazioni di

questo capitolo vi aiuteranno a determinare la causa del problema. Un output

inaspettato potrebbe includere immagini stampate a bassa risoluzione, colori

definiti per il progetto stampati in bianco e nero e font stampate incorrettamente

(vedere “Font” per informazioni su problemi di font e di stampa). Questo

capitolo elenca anche problemi di stampa comuni e offre suggerimenti per la

loro soluzione.

SOSTITUZIONE DEL DRIVER DELLA STAMPANTE

Per eseguire delle prove relativamente a un problema o a un conflitto associato
al driver della stampante, provate a utilizzare un altro driver per stampante. 
I driver per stampanti potrebbero non avere le stesse funzionalità del vostro
driver corrente, ma dovrebbero essere adeguati per condurre delle prove.

SOSTITUZIONE DEL DRIVER DELLA STAMPANTE IN MAC OS X
Per sostituire il driver della stampante, procedete come segue:

1  Aprite l’applicazione delle Preferenze del sistema(Applicazioni > Preferenze
di Sistema).

2  Fate clic su Stampa e Fax.

3  Nell’elenco delle stampanti, fate clic sul pulsante + per aggiungere un driver
di stampante.

4  In Mac OS 10.4, scegliete il nome di una nuova stampante dal menu a discesa
Stampante selezionata nella finestra di dialogo Stampa. In Mac OS10,5,
scegliete il nome di una nuova stampante dal menu a discesa Stampante
di default.

5  Chiudete l’applicazione delle Preferenze del sistema e ritornate in QuarkXPress.
Ripetete la prova. Se il problema non si verifica più con il nuovo driver della
stampante, ci potrebbe essere un conflitto con il vecchio driver o il vecchio
driver potrebbe essere danneggiato. Dovreste poter essere in grado di scaricare 
o ottenere un driver nuovo o aggiornato dal costruttore della stampante o da
Apple®, oppure di reinstallare il driver esistente.
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SOSTITUZIONE DELLA STAMPANTE IN WINDOWS
Per sostituire la stampante in Windows, procedete come segue:

1  Fate clic sul pulsante Start nella barra della applicazioni di Windows e scegliete
Impostazioni > Stampanti e Fax.

2  Se necessario, scegliete Archivio/File > Aggiungi stampante e seguite
istruzioni su schermo per selezionare un’altra stampante.

3  Fate clic sulla stampante che volete utilizzare per le prove e scegliete Imposta
come predefinito. L’impostazione della stampante come stampante predefinita
significa che tutte le applicazioni stamperanno automaticamente da questa
stampante per cui si consiglia di ripristinare la stampante di default non appena
avete concluso le prove.

4  Ritornate a QuarkXPress. Ripetete la prova, verificate che la stampante inclusa
nell’elenco della finestra di dialogo Stampa (Archivio/File > Stampa) sia quella
che avete definito come stampante di default. Se il problema non si verifica
più con il nuovo driver della stampante, ci potrebbe essere un conflitto con
il vecchio driver o il vecchio driver potrebbe essere danneggiato. Dovreste
poter essere in grado di scaricare o ottenere un driver nuovo o aggiornato
dal costruttore della stampante oppure di reinstallare il driver esistente.

ERRORI POSTSCRIPT

Un errore PostScript è un messaggio dalla stampante che indica che il prog-
etto non può essere stampato nel suo stato corrente. Gli errori PostScript
comprendono due parti: L’errore e l’offending comand (OFC). Ad esempio,
un errore PostScript potrebbe essere “limitcheck; ofc: stroke.” 

Gli errori PostScript possono essere causati da una serie di elementi, come ad
esempio una font, un’immagine o un oggetto QuarkXPress. Un errore PostScript
non significa necessariamente che il progetto o uno o più dei suoi componenti
siano danneggiati. L’errore potrebbe essere dovuto a condizioni della memoria
o a problemi del driver.

In genere, sapere l’errore PostScript esatto non è cruciale per una diagnosi e
risoluzione del problema; l’esecuzione di una procedura di prova su specifici
progetti dovrebbe identificare la causa del problema. Tuttavia, alcuni errori
PostScript sono associati a situazioni piuttosto specifiche e la conoscenza delle
loro cause può comportare un risparmio di tempo nel processo di identificazione
del problema.
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Potete utilizzare Gestione errore PostScript (PostScript Error Handler) per
identificare rapidamente il problema. Per utilizzare il Gestione errore
PostScript, procedete come segue:

1  Scegliete Archivio/File > Utilizzo e fate clic sul riquadro Dispositivo.

2  Selezionate Gestione errore PostScript (PostScript Error Handler). Se questa
opzione è selezionata, il progetto stamperà normalmente fino a quando non
incontra un problema. Il progetto interrompe la stampa prima che il problema 
si verifichi ma stamperà un’ultima pagina che include un riquadro contenente
l’elemento che ha causato il problema. La parte superiore della pagina identi-
ficherà se l’errore proviene da una finestra immagine, una finestra di testo, una
linea o un altro oggetto. Questo vi consentirà di identificare e di determinare
come gestire  l’elemento problematico.

ERRORI POSTSCRIPT PIÙ COMUNI
Segue una descrizione degli errori PostScript più comuni e alcuni suggerimenti
per evitarli o per risolverli.

• “limitcheck; ofc: image or colorimage”

  Questo errore è generalmente causato da un’immagine TIFF. Se l’errore si
verifica con un’immagine TIFF a colori, l’errore sarà “ofc: colorimage.” Riducete 
il valore di lpi (linee per pollice) utilizzando il menu a discesa Frequenza
(Archivio/File > Stampa > Colori) oppure diminuite il valore dpi (punti per
pollice) dell’immagine TIFF nella sua applicazione d’origine oppure utilizzate 
il menu a discesa Risoluzione (Archivio/File > Stampa > Dispositivo) Potete
anche cercare di deselezionare Output TIFF a piena risoluzione (Archivio/File >
Stampa > Immagini).

• “limitcheck; ofc: clip”

  Questo errore è solitamente causato da un’immagine EPS con un percorso di
ritaglio incorporato. Aprite il file EPS nel programma in cui era stato creato e
semplificate il percorso o aumentate l’appiattimento. Se avete creato un per-
corso di ritaglio di QuarkXPress utilizzando i comandi della scheda Oggetti >
Ritaglio, potete anche aumentare il valore di Uniformità (Oggetti > scheda
Ritaglio) del percorso di ritaglio, potete ridurre manualmente il numero di
punti o entrambi.

• “limitcheck; ofc: stroke or fill”

  Questo errore è solitamente causato da un file EPS complesso. Aprite il file EPS
nella sua applicazione d’origine e semplificatelo. Svariate applicazioni vi con
sentono di aumentare il valore di  appiattimento del file EPS o di suddividere
percorsi lunghi.
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VMERRORS
Ogni dispositivo di output PostScript ha un processore incorporato che traduce i
comandi PostScript nella pagina stampata vera e propria. Il processore di una
stampante si affida alla sua RAM interna (Random Access Memory) per com-
pletare la traduzione. Diverse stampanti PostScript hanno diverse quantità di
RAM installata. Se la stampante non ha una RAM sufficiente per renderizzare
la pagine, si verifica un errore “VMerror”. Solitamente la soluzione in presenza
di un “VMerror” è di semplificare la pagina, ridurre le dimensioni del supporto
(carta o pellicola) oppure inviare il progetto a un dispositivo di output con
più memoria.

***       La stampa su una stampante PostScript può ridurre la qualità di stampa 
dell’immagine EPS e molte opzioni della finestra di dialogo Stampa non
saranno disponibili.

PROBLEMI DI STAMPA COMUNI

Questa sezione riporta una serie di problemi di stampa comuni e offre suggeri-
menti su come risolverli. Queste soluzioni non sostituiscono la procedura di
diagnosi e di risoluzione dei problemi, sono piuttosto delle operazioni che si
possono compiere prima di affrontare prove complesse.

STAMPA A BASSA RISOLUZIONE DELLE IMMAGINI GRAFICHE
Se rilevate che una particolare immagine viene stampata a una risoluzione
più bassa di quella prevista oppure se diverse immagini vengono stampate a
bassa risoluzione, cercate prima di stampare l’immagine da un nuovo progetto.
Se l’immagine viene stampata correttamente dal nuovo progetto, provate a
sostituire l’immagine contenuta nel progetto originale.

Se l’immagine non viene stampata correttamente dal nuovo progetto, procedete
come segue:

1  Scegliete Archivio/File > Stampa > scheda Dispositivo).

2  Selezionate il campo Risoluzione. Se la risoluzione è impostata correttamente,
potrebbe essere utile ridigitalizzare l’immagine (se applicabile) e reimpostarla
nel vostro progetto QuarkXPress. 

***       Tenete presente che la massima risoluzione di stampa è determinata dalla
risoluzione della stampante. Se la risoluzione massima della stampante è 600 dpi,
non potete stampare a 1200 dpi.
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Se l’immagine è un file EPS, procedete come segue:

1  Verificate che l’immagine venga stampata su una stampante PostScript.

2  Accertatevi di usare un driver PostScript. Le immagini EPS sono destinate a un
output su stampanti PostScript (che utilizzano driver PostScript). Se stampate
un file EPS su una stampante non-PostScript potrebbe stampare ad una
risoluzione inferiore a quella a cui la stampante è in grado di stampare.

3  Se state stampando separazioni di colore, verificate l’impostazione del livello
PostScript per compatibilità scegliendo Archivio/File > Stampa e fate quindi
clic sul riquadro Avanzato nella finestra di dialogo Stampa. Se la vostra stam-
pante non supporta PostScript Level 3, modificate l’impostazione dal menu a
discesa Livello PostScript in PostScript Livello 2.

***       L’impostazione LPI potrebbe anche incidere sulla risoluzione delle vostre
immagini grafiche stampate.

STAMPA INCORRETTA DELL’ORIENTAMENTO NELLE 
STAMPANTI POSTSCRIPT
Se un progetto viene stampato con un orientamento incorretto, provate prima
di tutto un nuovo progetto per verificare se si ottengono gli stessi risultati. Se 
il nuovo progetto stampa correttamente, verificate le impostazioni del progetto
originale scegliendo Archivio/File > Stampa > riquadro Pagine. Accertatevi di
aver selezionato l’orientamento corretto.

Se le impostazioni sono corrette e il progetto non stampa ancora correttamente,
provate a cambiare il PPD. Per cambiare il PPD utilizzato da un progetto,
procedete come segue:

1  Scegliete Archivio/File > Stampa > riquadro Dispositivo.

2  Nel menu a discesa Descrizione stampante, modificate il PPD in Generico
bianco e nero, o Generico fotounità a scopo di prova. Se il progetto viene
stampato con il nuovo PPD, potrebbe esserci un problema nel PPD originale. 

***       I PPD vengono creati dai costruttori delle stampanti e vengono solitamente
forniti insieme alle stampanti PostScript. Per ulteriori informazioni, contattate
il costruttore della stampante.
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PROGETTI A COLORI STAMPATI IN BIANCO E NERO
Questo problema si presenta spesso come file EPS che vengono stampati a colori
mentre gli altri elementi del progetto viene stampato in bianco e nero. Questo
accade in quanto il contenuto di un file EPS non può essere manipolato da
QuarkXPress ma QuarkXPress può incidere sul contenuto delle immagini TIFF
in vari modi. Se siete incorsi in questo problema, procedete come segue:

1  Scegliete Archivio/File > Stampa > scheda Dispositivo.

2  Scegliete il PPD e accertatevi che il PPD riportato sia un PPD per colori. Se il
PPD non è per colori, provate con Generico colore, come prova. Se il PPD
Generico coloridà i risultati previsti, potrebbe esserci un problema con il PPD
originale. Potete contattare il costruttore della stampante per ottenere una
copia nuova o aggiornata di quel PPD.

3  Con QuarkXPress, i PPD non controllano output a colori. Gli utenti possono
invece specificare impostazioni di colore utilizzando sia il riquadro Colori
della finestra di dialogo Stampa sia le impostazioni Modalità e Modello
della finestra di dialogo Modifica l’impostazione di output (Comp./Edit >
Impostazioni del colore).Se continuate a incorrere in problemi di output
dopo aver corretto il PPD, regolate le impostazioni di output.

STAMPA LENTA CON LE STAMPANTI NON POSTSCRIPT
Quando QuarkXPress stampa su una stampante non PostScript, non può uti-
lizzare il PostScript e utilizza quindi i componenti del sistema per rasterizzare
la pagina per l’output. Se non si dispone di memoria sufficiente per rasterizzare
la pagina o se lo spazio sull’unità disco non è sufficiente per archiviare il file
raster che ne risulta e inviarlo alla stampante, i tempi di stampa potrebbero
essere lunghi.

STAMPA LENTA IN MAC OS X
Quando si stampano progetti QuarkXPress su una stampante non PostScript
in Mac OS X, QuarkXPress e Quartz (un linguaggio per schermo utilizzato da
Mac OS X) rasterizzano ciascuno determinati elementi. Il file raster che ne
risulta va archiviato (provvisoriamente) nell’unità disco rigido e inviato
alla stampante.

Per incrementare la velocità della stampa non PostScript in Mac OS X, 
procedete come segue:

1  Verificate di avere disponibile il massimo spazio possibile sull’unità disco in
modo da poter archiviare il file raster.

2  Accertatevi che le altre applicazioni non siano aperte in quanto applicazioni
aperte occupano parte della RAM necessaria a inviare i file alla stampante.
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STAMPA LENTA IN WINDOWS
Quando un’applicazione è in esecuzione in Windows, crea un file provvisorio
con estensione .tmp (pronunciato “temp”). Questo file si comporta come una
memoria virtuale, conservando e gestendo modifiche apportate durante il lavoro.
Quando l’applicazione si chiude, i file temporanei vengono automaticamente
eliminati. A volte, tuttavia questi file non vengono eliminati. Se ci sono molti
file temporanei nel vostro sistema, la stampa su stampanti non PostScript
potrebbe rallentare significativamente.

Per rimuovere i file temporanei, procedete come segue:

1  Uscite da tutte le applicazioni aperte.

2  Fate clic sul pulsante Start nella barra della applicazioni e scegliete Trova e
quindi File o Cartelle. Nel campo Nome, immettete *.tmp. Questo consentirà
di trovare tutti i file con estensione “.tmp”.

3  Fate clic su Trova ora. Se il numero di file provvisori trovati è alto (più di 25),
selezionate i file trovati nella finestra Trova e eliminateli. È consigliabile non
eliminare le cartelle elencate in quanto potrebbero costituire la directory
 provvisoria di default.

Se l’eliminazione dei file provvisori non è d’aiuto, provate a deframmentare
l’unità disco rigido. Quando QuarkXPress rasterizza le pagine, potrebbe essere
necessario disporre in modo continuativo di spazio libero per la creazione e
l’invio dei file raster. Se l’unità disco rigido viene frammentata, potrebbe non
esserci spazio continuo sufficiente per creare i file. La deframmentazione
dell’unità disco potrebbe creare spazio sufficiente per la creazione dei file.
In aggiunta, la deframmentazione dell’unità disco è comunque una buona
pratica di manutenzione.

Per deframmentare l’unità disco, procedete come segue:

1  Uscite da tutte le applicazioni aperte. Fate clic sul pulsante Start nella barra
delle applicazioni e scegliete Programmi > Accessori > Strumenti di sistema >
Utilità di deframmentazione dischi.

2  Selezionate l’unità disco che volete deframmentare e fate clic su OK. Potrebbe
venire visualizzato un messaggio di avvertenza che l’unità si trova a un livello
basso di frammentazione e non è necessario deframmentarla ora. Continuate
con la deframmentazione; anche se la frammentazione è bassa (5% o meno)
potrebbe incidere sulla stampa.

La deframmentazione potrebbe impiegare qualche minuto e non è una buona
idea eseguire applicazioni durante la deframmentazione dell’unità disco, per
cui è consigliabile iniziare questo processo prima di un intervallo di lavoro o
un’assenza dall’ufficio.

                                                                                                 PROBLEMI DI STAMPA COMUNI

                                                                                                       CAPITOLO 3: STAMPA   |   25



LISTA DI VERIFICA DEGLI ERRORI DI STAMPA

Questa sezione include una sequenza di controlli per verificare i 
risultati dell’output.

DOMANDE DA PORSI
1  È accesa la stampante?

2  La stampante ha carta, toner o inchiostro?

3  La stampante può stampare una pagina sul suo stato?

4  La stampante è connessa alla rete locale e/o al computer con QuarkXPress
in esecuzione?

5  Altri computer possono stampare sulla stampante?

6  Altre applicazioni installate nel computer dove risiede QuarkXPress possono
stampare senza problemi?

7  QuarkXPress può stampare altri progetti sulla stampante?

8  QuarkXPress può stampare alcune pagine dal progetto problematico ma non
altre pagine?

9  QuarkXPress può stampare la pagina o il progetto problematici quando alcune
font, immagini, file PDF o EPS non sono inclusi?

10  Se una font, un’immagine, un file PDF o EPS sono problematici, queste stesse
font, immagini, file PDF o EPS possono stampare da altre applicazioni?

11  Il progetto problematico può venire stampato con altre impostazioni di output
(ad esempio, RGB o CMYK compositi)?

12  È possibile stampare il progetto problematico su un’altra stampante?

13  Se la stampante è una stampante PostScript, è stato riportato un errore PostScript?

14  Se il problema ha generato un errore PostScript, qual è il nome dell’errore e qual
è l’offending command (OCF)?

15  Se il problema genera un errore PostScript, è un errore che vi è famigliare?
In questo caso, quali erano le condizioni che avevano generato questo errore
in passato?

16  Potete stampare il progetto problematico (o un progetto simile) con una
versione precedente di QuarkXPress?

17  Potete stampare il progetto problematico su un file PostScript e convertirlo in
PDF con Adobe® Distiller®?

18  Se Adobe Distiller restituisce un errore, qual è il nome dell’errore e 
dell’offending command.

    LISTA DI VERIFICA DEGLI ERRORI DI STAMPA

 26   |   CAPITOLO 3: STAMPA



19  Se Adobe Distiller non restituisce un errore, potete inviare il file PostScript
direttamente alla stampante?

20  QuarkXPress può esportare il progetto problematico come file PDF?

21  Se QuarkXPress può esportare il progetto problematico come un file PDF, il
PDF può venire visualizzato e stampato da Acrobat?

22  Verificate le dimensioni di file seguente: 

• progetto problematico

• font, immagini, file PDF e EPS associati

• file PostScript generato dal progetto problematico

• file PDF generato dal progetto problematico

23  Verificate il tempo necessario per:

• aprire il progetto in QuarkXPress

• stampare il progetto (oppure se non riesce a stampare, il periodo di tempo
prima di ricevere il messaggio di errore)

• esportare il progetto come PDF (oppure se non riesce a esportare, il periodo di
tempo prima di ricevere il messaggio di errore)

24  È stato possibile stampare una versione precedente del progetto senza incorrere
in errori?

25  In questo caso, quali sono le modifiche apportate al progetto tra la stampa
riuscita e il momento in cui si è verificato l’errore?

26  Se il problema non è un errore che impedisce al progetto di essere stampato,
qual è la natura del problema?

27  Se il problema si riferisce alla qualità di stampa, qual è la differenza tra la
qualità di stampa prevista e la qualità di stampa effettiva?

28  Il problema si verifica costantemente o in modo intermittente?

29  Avete trovato metodi o tecniche che sembrano essere in grado di mitigare
il problema?

30  Il problema si verifica soltanto con un progetto particolare o con una data
categoria di progetti?

31  Il problema si verifica sempre nello stesso modo o si sono verificati molteplici
problemi di qualità e/o messaggi di errore?
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Capitolo 4: Font
Quando le font non funzionano correttamente, ciò può alterare la visualizzazione

su schermo e le operazioni di stampa e a volte non è semplice individuare le

parti della font che causano il problema. QuarkXPress dispone di funzioni di

gestione delle font ma poiché le font sono risorse a livello di sistema e vengono

condivise da varie applicazioni, il vostro successo potrebbe dipendere dalle

funzioni di gestione delle font a livello di sistema. Mac OS e Windows

dispongono di controlli delle font e molti produttori di font sviluppano anche

utilità di gestione delle font.

FONT SUPPORTATE E NON SUPPORTATE

Mano a mano che i produttori di font e le tecnologie del settore si evolvono, gli
utenti hanno disponibili più scelte ma hanno anche più variabili da gestire
quando le font causano dei problemi.

FONT NON SUPPORTATE
Se non siete sicuri di un formato di font, potete utilizzare una utility di gestione
delle font per determinare il tipo di font. Tenete inoltre presente che in Mac OS
non si tratta soltanto di una questione di supporto del formato. Alcuni script
non sono supportati dalla gestione font di Mac OS X Carbon, come ad esem-
pio Devanagrai e Ebreo. Se la vostra font è una font Mac Suitcase e l’ID della
risorsa FOND è in questo range di script non supportati, la vostra font non
verrà caricata.

FAMIGLIE DI FONT E ISTANZE DI FONT
Le font elencate nei menu di font di QuarkXPress sono famiglie di font, non
istanze di font. la maggior parte delle famiglie di font ha tipicamente quattro
istanze di font, — normale, grassetto, corsivo e grassetto/corsivo. Utilizzate il
menu Stile o il pulsante dello stile del carattere nella palette delle Misure per
specificare l’istanza di font corretta.

Se un’istanza di font non è disponibile in una famiglia di font, QuarkXPress
simulerà quell’istanza. Ad esempio, se una famiglia di font non include
l’istanza in corsivo di una font, QuarkXPress simula l’istanza in corsivo
inclinando l’istanza normale.
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In alcuni casi, l’istanza di una font mancante è sufficiente affinché QuarkXPress
visualizzi dei messaggi che indicano che un’intera font non è disponibile.

ARCHIVIAZIONE FONT
Particolarmente in Mac OS, l’archiviazione di font per molteplici utenti che
utilizzano lo stesso computer può complicare l’identificazione di font prob-
lematiche. Potrebbe essere necessario dover stabilire quale versione di una
particolare font è all’origine del problema. Un sistema utile per semplificare
l’archiviazione delle font in Mac OS è di raccogliere tutte le font nella cartella
“Shared” (Condivisione) all’interno della cartella “Users” (Utenti).

UTILITÀ DI GESTIONE DELLE FONT

Mano a mano che il numero di font e le tecniche di gestione delle font con-
tinuano a crescere, le opzioni di utilità di gestione delle font aumentano. Queste
utilità possono aiutarvi a identificare e a risolvere molti problemi di font.

Una font danneggiata può causare un arresto anomalo di QuarkXPress.
L’utilizzo di uno strumento di gestione delle font (oppure il metodo di ricerca
binario), può identificare le font danneggiate. E sono disponibili molte utilità 
di gestione delle font in grado di riparare font danneggiate.

Se il testo che digitate in una determinata font non viene visualizzato su schermo,
potrebbe essere indicativo di una tabella di font o di risorse danneggiate. Uno
strumento di gestione delle font potrebbe essere utile per identificare e riparare la
font danneggiata.

SOSTITUZIONE DI FONT NEGLI OUTPUT DI STAMPA

Quando si stampa su un dispositivo PostScript, le font PostScript Type 1 chenon
risiedono nella memoria della stampante devono venire caricate nella stam-
pante. Se la font PostScript Type 1 necessaria non viene caricata, potrebbe
verificarsi una sostituzione dei seguenti tipi di font (—nota anche come
“sostituzione Courier”):

SOSTITUZIONE DI FONT DURANTE LA STAMPA DI UN
PROGETTO CON FONT MANCANTI
Quando viene visualizzata l’avvertenza “ ‘nome_progetto’ usa font non installate
nel sistema”, sono disponibile due opzioni: Elenco font o Continua. Facendo
clic sul pulsante Elenco font potete sostituire qualsiasi font mancante con font
 installate nel vostro sistema. Facendo clic su Continua si conservano le infor-
mazioni sulla font mancante qualora il progetto venga trasferito su un altro
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computer che dispone delle font necessarie oppure se installate le font neces-
sarie in un secondo tempo. Se tuttavia stampate il progetto senza sostituire le
font mancanti, la font Courier residente nella stampante sostituirà automati-
camente le font mancanti.

Se non fate clic su Elenco font quando viene visualizzato il messaggio di
avvertenza, potete specificare la font di sostituzione in un secondo tempo
scegliendo Utilità > Utilizzo > Font. Potete anche scaricare selettivamente
determinate font tramite le finestre di dialogo Stampa, Salva la pagina
come EPS e Esporta come PDF

SOSTITUZIONE CON LA FONT COURIER NELLE IMMAGINI EPS
Un file Encapsulated PostScript (EPS) contiene un codice che consente al
dispositivo PostScript di stampare il file ad alta risoluzione. I file EPS possono
inoltre  includere informazioni sulle font utilizzate nel file. Se una font PostScript
Type 1  a cui si fa riferimento nel file EPS non può essere individuata né nel
computer né nella stampante, la font Courier la sostituirà automaticamente.

Quando importate un file EPS in QuarkXPress, viene rappresentato su schermo
come anteprima a bassa risoluzione — non state in effetti visualizzando infor-
mazioni PostScript. Anche se l’anteprima viene visualizzata correttamente sullo
schermo, la sostituzione Courier può sempre avvenire durante la stampa.

***       QuarkXPress scannerizza automaticamente le immagini EPS importate e vi
informa nel caso di font mancanti durante la stampa del file.

SOSTITUZIONE CON LA FONT COURIER IN WINDOWS
Se si sta verificando una sostituzione della font Courier in Windows, potete
iniziare generando un elenco delle font utilizzate nel vostro progetto. Procedete
come segue:

1  Aprite il progetto problematico.

2  Scegliete Archivio/File > Raccolta dati per la stampa Nella finestra di dialogo
Raccolta dati per la stampa, selezionate Solo rapporto. Questo genererà un
rapporto contenente informazioni utili sul layout attivo. Il report verrà creato
con un file “XPress Tags”.

3  Una volta generato il rapporto, importate il file “XPress Tags” nel nuovo
progetto QuarkXPress.

4  Fate riferimento alla sezione “Font del layout” del file di testo importato per un
elenco di font utilizzate sia nel layout sia in tutte le immagini EPS importate. 

***       Se non avete familiarità con la funzionalità Raccolta dati per la stampa,
fate riferimento alla Guida a QuarkXPress .
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Potete anche determinare le font utilizzate all’interno di un layout scegliendo
Utilità > Utilizzo > scheda Font. Tutte le font utilizzate nel layout verranno
elencate qui. Questo elenco include le font utilizzate nei fogli di stile anche se
i fogli di stile non vengono applicati, ma non include informazioni sulle font
utilizzate nei file EPS.

Quando disponete di questo elenco, accertatevi che tutte le font utilizzate nel
layout siano correttamente installate nel vostro sistema. Se state utilizzando
un’utilità di font per la gestione delle vostre font, consultate la documentazione
dell’utilità per istruzioni sull’installazione e  sull’apertura delle font.

Se si verifica ancora una sostituzione automatica con la font Courier, significa
che i file delle font della stampante potrebbero essere danneggiati. Potrebbe
essere necessario reinstallare le font mediante i dischi o il CD-ROM originali
del produttore delle font.
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Capitolo 5: Messaggi di errore
Questo capitolo descrive alcuni messaggi d’errore e fornisce suggerimenti per la

loro soluzione. Se si verificano errori PostScript durante la stampa, vedere la

sezione “Errori PostScript” nel capitolo 3, “Stampa”.

MESSAGGI ASSOCIATI A PROGETTI DANNEGGIATI

I progetti QuarkXPress, come qualsiasi altra forma di dati archiviati elettroni-
camente , possono divenire danneggiati. Il danno può generare una serie di
sintomi diversi, ma il problema rimane lo stesso: i dati non possono venire
interpretati dall’applicazione o dal sistema operativo.

Tutti i dati che costituiscono un progetto sono suscettibili a possibili danni,
da oggetti contenuti nel file, come ad esempio anteprime di immagini o
oggetti di QuarkXPress, alla struttura dei file, come ad esempio informazioni 
di intestazione o il resource fork di Mac OS X.

La possibilità di recupero di un file dipende da dove risiede il danno. Se il danno
risiede nella struttura essenziale del progetto, la possibilità di recupero è limitata;
se il danno risiede in un oggetto contenuto nel file, le possibilità di recupero
sono maggiori.

Potete determinare il tipo di danno arrecato tramite i messaggi di errore
visualizzati. Questi messaggi di errore sono generalmente indicativi di una
struttura danneggiata:

• Formato di file non corretto [–70]

• Fine inaspettata del file [–39]

• Memoria esaurita [–108]

FORMATO DI FILE NON CORRETTO [–70]
Questo è un messaggio di errore a livello di sistema che indica che l’intes-
tazione di un file risulta danneggiata. Il danno al progetto a questo livello è
difficile da risolvere.

Come sempre, la prevenzione è la cura migliore. Tenete sempre dei backup
ai quali avete assegnati nomi diversi. Eseguite un sistema pulito, utilizzando
soltanto estensioni e pannelli di controllo sicuri e commercialmente disponibili.
Allocate una quantità di memoria adeguata per l’esecuzione di QuarkXPress.
Se un progetto manifesta un comportamento erratico, provate ad adottare
la procedura di trascinamento delle miniature per spostare le pagine in un
progetto separato.
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Potete anche cercare di aprire il progetto in QuarkXPress su un’altra piattaforma.
Poiché QuarkXPress per Mac OS e QuarkXPress per Windows accedono all’in-
testazione di un file in modo diverso, potreste essere in grado di aprire il
progetto su una piattaforma e non su un’altra.

FINE INASPETTATA DEL FILE [–39]
La fine inaspettata di un file [–39] significa che il marcatore di fine del file è
danneggiato o mancante o i dati sulla fine del file non raggiungono la posizione
definita dal marcatore di fine del file. 

Il danno al progetto a questo livello è purtroppo difficile da risolvere. Se le
dimensioni del file, dopo che questo messaggio è stato visualizzato, sono
drammaticamente inferiori alle dimensioni originali, le possibilità di recupero
sono minime. È consigliabile usare una copia di backup se disponibile.

Potete anche provare a copiare il file su un volume diverso. Provate anche ad
aprire il file su un’altra piattaforma. Questo accorgimento a volte riscrive le
informazioni di intestazione sul nuovo volume.

MEMORIA ESAURITA [–108]
Memoria esaurita [–108] può essere a volte fuorviante. Potrebbe in effetti sig-
nificare che l’applicazione non dispone di memoria sufficiente per aprire il
progetto. Ciò potrebbe verificarsi se all’applicazione non è stata allocata una
quantità di memoria sufficiente, se non era disponibile sufficiente memoria
da allocare o se il computer non ha semplicemente memoria sufficiente per
l’esecuzione di un’applicazione o l’apertura di un progetto.

Il messaggio di errore può anche significare che il progetto è danneggiato.
Quando QuarkXPress identifica il file e inizia ad aprire il progetto, l’appli-
cazione rileva una condizione di errore e gira ciclicamente lungo il progetto
fino a quando la memoria non è esaurita. La condizione di errore può verificarsi
in una parte qualsiasi del file: In un oggetto o nel suo contenuto, nei dati sul
livello della pagina o nella struttura esenziale del progetto.

Il messaggio di errore può a volte essere causato da una font danneggiata.
Provate a disattivare le font e quindi ad aprire il progetto.

RECUPERO DA PROGETTI DANNEGGIATI

I file possono venire danneggiati se salvate un progetto su un supporto dan-
neggiato o se il supporto viene danneggiato in un secondo tempo. A seconda
della causa del danno o  del grado di danno subito, potreste essere in grado o
meno di recuperare il progetto. 
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Per accertarsi di non perdere dati essenziali, eseguite una copia di backup dei
vostri progetti a intervalli regolari, preferibilmente su supporti esterni o su
un’unità diversa nel vostro sistema. Potete anche procedere come segue per
ridurre la possibilità di danni al file: 

1  Se un progetto manifesta un comportamento erratico, provate ad adottare la
procedura di trascinamento delle miniature per spostare le pagine in un
progetto separato.

2  Eseguite periodicamente la manutenzione del disco rigido o di altri supporti,
tramite un’utilità per dischi. Gli utenti di Windows dovrebbero deframmentare
regolarmente le loro unità disco.

3  Se utilizzate la funzionalità Backup automatico in QuarkXPress, uno dei file
di backup deve essere facilmente accessibile. Quando questa preferenza di
applicazione è attivata (QuarkXPress/Modifica > Preferenze > scheda Salva)
e il vostro progetto è danneggiato, potete utilizzare il file di backup.

RECUPERO DI UN PROGETTO DANNEGGIATO
Se non disponete di una copia di backup del vostro progetto e volete recuperare
il progetto, seguite la procedura descritta di seguito nonché le azioni suggerite
per ogni messaggio di errore.

1  Provate a isolare QuarkXPress. Per istruzioni, vedere “Problemi a livello
applicazione” nel capitolo 2, “Arresti anomali.”

2  Provate ad aprire una copia del progetto in un’applicazione di gestione 
del testo come ad esempio Microsoft Word. Questo eliminerà tutti gli
attributi e le immagini grafiche dal progetto, ma potrebbe conservare parti 
di testo utilizzabile.

3  Provate a eseguire le azioni descritte in “Problemi a livello di progetto” nel
Capitolo 2, “Arresti anomali”. Non tutte le azioni potrebbero essere applicabili
al vostro progetto danneggiato.

4  Provate a copiare il progetto da un volume a un altro. Trascinando il progetto su
un disco o un’unità disco diversi, potrebbe essere possibile riaprire il progetto
dopo averlo riscritto.

5  Se avete accesso a QuarkXPress da un’altra piattaforma, provate ad aprire il
progetto su quella piattaforma. A volte è possibile aprire il progetto su un’al-
tra piattaforma senza alcun problema. In questo caso, risalvate il progetto e
riapritelo nella piattaforma originale.
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RIPARAZIONI MINORI
Quando aprite un progetto, se ricevete un messaggio che identifica un danno
che richiede riparazioni non complesse, QuarkXPress cercherà di rimediare al
problema del file affrontando diverse possibili cause. Se il progetto si apre senza
problemi a seguito delle riparazioni eseguite da QuarkXPress, accertatevi di
verificare quanto segue:

• Il testo scorre come previsto e gli attributi del testo non sono stati modificati.

• La finestra di dialogo Colori visualizza tutti i colori del progetto

• La finestra di dialogo SG include tutte le specifiche 
(con le impostazioni specificate).

• La finestra di dialogo Fogli di stile include anche tutti i fogli di stile che 
avevate specificato. 

• Tutte le àncore dei layout Web conservano il loro contenuto originale e la
loro posizione. (L’àncora è semplicemente un indicatore associato a un punto
specifico del layout Web.)

ALTRI MESSAGGI DI ERRORE E AVVERTENZE

QUESTO PROGETTO NON PUÒ VENIRE APERTO DA QUESTA
VERSIONE DI QUARKXPRESS. [17]
Il messaggio d’errore, “Questo progetto non può venire aperto da questa
versione di QuarkXPress. [17]” verrà visualizzato in una delle situazioni
descritte di seguito. Nella maggior parte dei casi, potete aprire il progetto 
utilizzando la versione appropriata di QuarkXPress.

DOCUMENTI NON-QUARKXPRESS 
In QuarkXPress per Windows riceverete il messaggio di errore “Questo progetto
non può essere aperto da questa versione di QuarkXPress. [17]” se cercate di
aprire un documento non QuarkXPress utilizzando Archivio/File > Apri Potete
anche ricevere questo messaggio di errore se fate doppio clic su un documento
QuarkXPress a cui era stata assegnata un’estensione di file QuarkXPress
erronea, come ad esempio “.qxp” o “.qpt.”

Osservate il campo Tipo di file nella finestra di dialogo Archivio/File >
Apri per verificare che il file che si sta cercando di aprire sia di fatto un
progetto QuarkXPress.

***       Un progetto salvato in QuarkXPress per Windows potrebbe non venire
visualizzato nella finestra di dialogo Archivio/File > Apri se non possiede 
e l’estensione di file corretta di tre caratteri.
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A un documento non QuarkXPress salvato inavvertitamente nella
piattaforma Windows con un’estensione QuarkXPress come ad esempio
“.qxp” o “.qpt”, potrebbe venire assegnato un tipo di progetto e un codice di
creazione QuarkXPress se viene copiato in un computer Mac OS X oppure 
se viene copiato in un server Windows NT®. Quando cercato di aprire questo
documento in QuarkXPress per Mac OS X, riceverete un messaggio di errore
“Questo progetto non può essere aperto da questa versione di QuarkXPress. [17].”

FILE COMPRESSO
I file vengono spesso codificati o compressi quando vengono trasmessi tramite
Internet o al fine di conservare spazio. Se tentate di aprire un file compresso o
codificato in QuarkXPress, riceverete il messaggio di errore [17]. Accertatevi di
decomprimere o decodificare i file prima di aprirli in QuarkXPress.

PROGETTO DANNEGGIATO
I progetti danneggiati possono causare numerosi messaggi di errore o di
avvertenza, tra cui il messaggio di errore “Questo progetto non può essere
aperto da questa versione di QuarkXPress”. [17].” Adottare la procedura
descritta nella sezione “Recupero di progetti danneggiati” per cercare di
recuperare il progetto.

VERSIONI DI DIMOSTRAZIONE DI SOFTWARE XTENSIONS INSTALLATI
Una versione completamente funzionale di QuarkXPress potrebbe venire
lanciata in modalità dimostrativa se è stata caricata una copia dimostrativa o
di valutazione del software XTensions. (Verrà visualizzata un’avvertenza se
QuarkXPress viene lanciato in modalità dimostrativa). I progetti salvati con
QuarkXPress in modalità dimostrativa non potranno venire aperti in una
versione funzionante di QuarkXPress. Potete tuttavia riaprire i progetti con gli
stessi software XTensions di dimostrazione caricati.

Per informazioni sui software XTensions di dimostrazione funzionanti
con QuarkXPress, consultate lo sviluppatore o la documentazione del
 software XTensions.

PROGETTI SALVATI IN VERSIONI PIÙ RECENTI DI QUARKXPRESS
I progetti salvati in versioni più recenti di QuarkXPress non possono venire
aperti utilizzando versioni precedenti. Questo non è tuttavia applicabile a
revisioni e patch correttivi di minore importanza sviluppati per una 
particolare versione. 

Ad esempio, un progetto QuarkXPress 6.5 potrebbe venire aperto in
QuarkXPress 6.1 (o vice-versa) ma un progetto QuarkXPress 8 non può 
venire aperto in QuarkXPress 7.
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ALCUNE IMPOSTAZIONI SALVATE CON QUESTO PROGETTO SONO
DIVERSE DA QUELLE DEL FILE “XPRESS PREFERENCES” (MESSAGGIO
DI PREFERENZE NON CORRISPONDENTI)
Quando aprite un progetto contenente informazioni sulla tabella di kern o 
di track, eccezioni di sillabazione o dati su cornici che non corrispondono 
alle impostazioni correnti definite nel file delle preferenze di QuarkXPress,
QuarkXPress visualizza un’avvertenza di Preferenze non corrispondenti. 

Le impostazioni delle aree indicate di seguito causeranno la visualizzazione
dell’avvertenza Preferenze non corrispondenti se non corrispondono a quelle
del file delle preferenze di QuarkXPress:

• Informazioni sulle tabelle personalizzate di kern/track (Utilità > Modifica
tabella di kern o Utilità > Modifica del track) 

• Eccezioni di sillabazione personalizzate (Utilità > Eccezioni di sillabazione)

• Tratteggi e strisce personalizzati (Comp./Modifica > Tratteggi e strisce):

  L’area superiore del messaggio di avvertenza indica le impostazioni di preferenza
che non corrispondono al file corrente “XPress Preferences”. Ad esempio,
potrebbe venire visualizzato il messaggio “Alcune impostazioni salvate con
questo progetto sono diverse da quelle del file “XPress Preferences”:

• Le impostazioni di Kern/track non corrispondono.

• Le impostazioni delle eccezioni di sillabazione non corrispondono.

L’area inferiore di questa finestra di dialogo offre due opzioni:

• Usa le preferenze XPress Questa opzioni utilizza le informazioni definite nei
file attivi delle preferenze di QuarkXPress. Qualsiasi impostazione personalizzata
(tra cui le cornici personalizzate) archiviata in precedenza nel progetto verrà
eliminata una volta che il progetto viene salvato. Ciò potrebbe causare un
riscorrimento del testo nell’ambito del progetto. Qualsiasi modifica apportata
alla tabella di kern, alla tabella di track e alle eccezioni di sillabazione verrà
salvata nel file delle preferenze di QuarkXPress e diverrà disponibile per l’uso
con altri progetti.

• Mantieni le impostazioni del progetto. Questa opzione utilizza le impostazioni
di preferenze archiviate con il progetto. Tutte le impostazioni personalizzate
verranno conservate e lo scorrimento del testo rimarrà invariato. In aggiunta,
qualsiasi modifica apportata alla tabella di kern, alla tabella di track e alle
eccezioni di sillabazione verrà salvata con il progetto soltanto e non nel file
delle preferenze di QuarkXPress.
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Se le preferenze non corrispondenti creano un problema nel vostro workflow,
è consigliabile creare un file master delle preferenze di QuarkXPress e distribuirlo
a tutti i membri del vostro gruppo. Istruite tutti gli utenti a non modificare
le tabelle di kern o di track, le eccezioni di sillabazione o i dati sulle cornici
personalizzate. Tenete inoltre una copia di backup del vostro file master con
le preferenze di QuarkXPress.

QuarkXPress crea un set delle preferenze di QuarkXPress, con le impostazioni di
default se non trova un file con il set delle preferenze di QuarkXPress quando
l’applicazione viene lanciata. 
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Capitolo 6: Come contattare il
supporto tecnico di Quark

Dopo aver provato le tecniche di diagnostica e risoluzione di problemi descritte

in questa guida, se avete ancora problemi potete cercarne la soluzione nel

Technical Support Database, accessibile al sito Web euro.quark.com. Se continu-

ate ad aver bisogno di assistenza, raccogliete tutte le informazioni necessarie

sul vostro ambiente di lavoro al fine di migliorare la qualità del vostro contatto

con il Supporto tecnico di Quark e possibilmente raggiungere una soluzione

nel tempo più breve possibile.

CREAZIONE DI UN REPORT SUL PROFILO DEL SISTEMA

Potete generare un report sul profilo del sistema contenente un elenco delle
informazioni chiave sul vostro ambiente di lavoro con QuarkXPress.

Avrete bisogno di identificare la versione dei componenti chiave, ad esempio
QuarkXPress, Mac OS, Windows, software XTensions e file di stampa. Potreste
anche aver bisogno del numero di serie.

Per generare un report sul profilo del sistema, procedete come segue:

1  Per visualizzare la finestra Ambiente di QuarkXPress, tenete premuto
Option mentre scegliete QuarkXPress > Inform. su QuarkXPress (Mac OS)
oppure premete Alt prima di scegliere Aiuto > Informazioni su
QuarkXPress (Windows).

2  La finestra di dialogo Ambiente di QuarkXPress visualizza il numero di
versione, il livello di patch correttivo e il numero di build della vostra copia
di QuarkXPress, oltre al numero di serie, la lingua del SO, la stampante di
default, il driver della stampante, i Servizi di rete e un elenco di software
XTensions installati.

Per generare un report sul profilo del sistema operativo per Mac OS:

1  Scegliete Archivio/File > About this Mac (Informazioni sul Mac). Viene
visualizzata la finestra di dialogo About this Mac (Informazioni sul Mac).
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2  Fate clic su Più inform… nella finestra di dialogo About This Mac. Viene
lanciata l’applicazione System Profiler ( Profilo di sistema) con una finestra
che visualizza informazioni dettagliate su hardware, software e impostazioni
di rete.

3  Scegliete Archivio/File > Salva col nome per creare un file separato con
questa informazione. Le opzioni di formato includono XML, Rich Text
Format (RTF) o testo normale.

Per generare un report sul sistema operativo per Windows:

1  Scegliete Start > Programmi > Accessori > Strumenti del sistema >
Informazioni di sistema. Viene visualizzata la finestra System 
Information  (Informazioni sul sistema) con informazioni su risorse 
hardware, componenti, ambiente  software, impostazioni Internet e 
applicazioni di Microsoft Office.

2  Scegliete Archivio/File > Esporta. Viene visualizzata la finestra di dialogo
Esporta come.

3  Scegliete un percorso per il file di testo.

INVIO DI FILE AL SUPPORTO TECNICO DI QUARK

Se il problema in cui siete incorsi persiste anche dopo aver seguito le procedure
di diagnostica e risoluzione problem descritte prima, dovete probabilmente
contattare il supporto tecnico di Quark. Sebbene possiate inviare file di
dimensioni limitate tramite e-mail al supporto tecnico di Quark, dovrete caricare
eventuali file di grandi dimensioni.

1  Create una cartella e copiate al suo interno il progetto problematico.

2  Create un profilo di sistema, esportatelo come file di testo e copiatelo nella
cartella creata al punto 1.

3  Se applicabile, copiate i file di registro dell’arresto anomalo nella cartella.

4  Comprimete il file utilizzando una delle molteplici utilità di compressione di
file disponibili per Mac OS e per Windows, ad esempio WinZip.

5  Caricate il file compresso nel seguente percorso: euro.quark.com/en/service/
desktop/support/fileupload/.

    CREAZIONE DI UN REPORT SUL PROFILO DEL SISTEMA

 40   |   CAPITOLO 6: COME CONTATTARE IL SUPPORTO TECNICO DI QUARK


	Indice
	Introduzione
	Utilizzo di questa guida
	Presupposti
	Convenzioni tipografiche


	In che cosa consiste esattamente la diagnostica e risoluzione di problemi?
	Procedura di diagnostica e risoluzione di problemi
	Esecuzione della procedura di diagnostica e risoluzione diproblemi
	Tre modelli di diagnostica
	Il metodo binario
	Problemi casuali di diagnostica e risoluzione di problemi

	Arresti anomali
	Segnalazione di problemi di interruzione anomale in Mac OS
	Segnalazione di arresti anomali in Windows
	Problemi a livello di progetto
	Aggiunta di layout a un altro progetto 
	Trascinamento di pagine tra variprogetti in modalità Miniature
	Arresto anomalo durante l’apertura dei progetti
	Arresto anomalo durante l’importazione di immagini grafiche (Mac OS)
	Arresto anomalo durante la stampa di immagini grafiche
	Font
	Utilizzo dell’utilità di gestione dellefont
	Oggetti di QuarkXPress
	PPD

	Problemi a livello di applicazione
	Isolamento di QuarkXPress

	Prove sui file a livello di sistema
	Font
	PPD

	Problemi a livello di sistema
	Collegamento come un utente diverso in Mac OS X


	Stampa
	Sostituzione del driver della stampante
	Sostituzione del driver della stampante in Mac OS X
	Sostituzione della stampante in Windows

	Errori PostScript
	Errori Postscript più comuni

	Problemi di stampa comuni
	Stampa a bassa risoluzione delle immagini grafiche
	Stampa incorretta dell’orientamento nelle stampanti PostScript
	Progetti a colori stampati in bianco e nero
	Stampa lenta con le stampanti non PostScript

	Lista di verifica degli errori di stampa
	Domande da porsi


	Font
	Font supportate e non supportate
	Font non supportate
	Famiglie di font e istanze di font
	Archiviazione font

	Utilità di gestione delle font
	Sostituzione di font negli output di stampa
	Sostituzione di font durante la stampa di un progetto con font mancanti
	Sostituzione con la font courier nelle immagini EPS
	Sostituzione con la font courier in Windows


	Messaggi di errore
	Messaggi associati a progetti danneggiati
	Formato di file non corretto [–70]
	Fine inaspettata del file [–39]
	Memoria esaurita [–108]

	Recupero da progetti danneggiati
	Recupero di un progetto danneggiato
	Riparazioni minori

	Altri messaggi di errore e avvertenze
	Questo progetto non può venire aperto da questa versione di QuarkXPress. [17]
	Documenti non-QuarkXPress 
	"Alcune impostazioni salvate con questo progetto sono diverse da quelle del file XPress Preferences” (messaggio di preferenze non corrispondenti)


	Come contattare il supporto tecnico di Quark
	Creazione di un report sul profilo del sistema
	Invio di file al supporto tecnico di Quark


